
COMPUTER PLUS MEETING 

  
Computer Plus will meet on Thursday April 19, 2012 at 1:00 PM at Laurel Manor Recreation 

Center. 
  
The subject of the meeting will cover Organization with Favorite Programs by John Campbell.  
  
All Village residents are invited to attend the meeting. 
  
For more information please contact Pete Rosendahl at 352-409-7247. 
  
My laptop and email list went to the graveyard but we are trying to resurrect the hard drive to get it 
back. 
In the meantime, we built a temporary list and we hope that you are OK with receiving this meeting 
announcement.  We will make a change in how we manage the email list before the next meeting. 
Thanks for your patience and understanding.   PR 
  
If you need any more information or have any comments please let us know: 
  
Pete Rosendahl   pjrdbs@msn.com    
*********************************************************************************************** 

  
   

The Villages Computer Club 
 

The Villages Computer Club will host another great WORKSHOP event at 
La Hacienda Recreation Center on Friday April 20th at 1:00 pm.  
  
Here in an informal setting you will be able to get your computer 
questions and concerns answered by knowledgeable experts. The 
subject tables will be iPad, AOL, Email, Kindle Fire, Computer Security, 
Photography, Facebook, Skype, Questions on XP, VISTA and Windows 7 
and General PC questions. 
 
This is always a time where you can gain lots of helpful computer 
knowledge and have a good time. We will have refreshments and our 
50/50 and door prices. 
  
For more information on the VCC please reference the clubs web site  or 
email Paul Rabenold at TVCC.Pres@gmail.com 

  
Freedom of conscience for all Americans and for all peoples of the world 
  
American Catholic Bishops Statement on Religious Liberty 
  
Click here: http://www.usccb.org/issues-and-action/religious-
liberty/upload/Our_First_Most_Cherished_Liberty.pdf  



**************************************************************************************** 
HEADS UP!!! 
There has been a huge amount of calls and/or emails trying to convince folks that 
they have a virus (or other computer problem) and an offer to 'fix' the problem.  
PLEASE DON'T RESPOND.  These are Phishing calls and emails trying to get 
your credit card, your personal info,etc.  OFten they claim to be from your anti-
virus manufacturer or from Microsoft. 
  
Quote from Microsoft: 
“Microsoft takes the privacy and security of our 
customers and partners personal information very 
seriously. We are advising customers to treat all 
unsolicited phone calls with skepticism and not to 
provide any personal information to anyone over the 
phone or online. Anyone who receives an unsolicited 
call from someone claiming to be from Microsoft 
should hang up. We can assure you Microsoft does 
not make these kinds of calls.” 

“For more information on this scam and how to 
protect yourself against this, please click here” 

  

Our Tip: 
If you receive one of these unsolicited phone calls, hang 
up and do not download anything they ask you to. And 
definitely don’t hand over your credit card details, just 
because someone mentions the well known name 
‘Microsoft’. 
If you have allowed them to take control of your computer, 
or download their ‘fix’ software, it is possible they have 
infected your computer with a virus or other malware. To 
avoid the potential for identity theft issues and computer 
problems due to the viruses or malware that they may 
have downloaded, we would strongly recommend that 



you take your computer to a reputable computer 
repair shop to have it thoroughly checked out. 
 

Tags: desktop advice, laptop advice, scam, virus 

Posted in Tips and Advice  

************************************************************ 

Connect to an Available Wireless Network 

When you connect your computer to a network by using an Ethernet cable, Win 7 

automatically creates the network connection. To connect to a wireless network for the first 

time, YOU need to make the connection. 

Connect to an Available Wireless Network 

1. In the notification area look for either a single monitor screen or a stack of reeds toy. 

This will be the icon for the wireless connection. Click that icon to open the wireless 

network box where there will be a list of wireless networks that are available.  If the 

network says Secured, it means you must enter a wep or wpa code before you can connect. 

2. There may also be a box to click to show Available Wireless Networks. you should 

recognize your own wireless network since you set it up. 

3. Click the wireless network to which you wish to connect, then click the Connect button. 

If necessary enter the WEP or WPA password.  

4. In Win 7 each network profile includes these settings: 

 a. Network discovery - can the computer see and be seen by other computers 

connected to the same network. 

 b. File and printer sharing - shows if network users can access files and printers you 

have shared. 

 c. Public folder sharing - shows if network users can access files stored in the Public 

folders in your computer. 

 d. Media streaming - shows if network users can access music, videos and pictures 

stored in your media library. 

 e. File sharing - shows the security requirements for devices that connect to your 

computer's file sharing connections. 

 f. Password-protected sharing - shows if files are available to any network user or 

only to users with user accounts in your computer. 



 g. HomeGroup connections - shows if only those with User Accounts can be joined 

to your homegroup.  

Note: Network connection types and homegroups may not be available on a computer 

running an earlier version of Windows. 

****************************************************************************************************
****** 

Internet Explore Script error 

Go to Tools, Internet Options, Advanced, Browsing, scroll down the list  and uncheck "Enable third party browser 

extensions."  

************************************************* 

Changing Web page fonts and background colors 

When Web authors and designers create Web pages, they often specify particular type (font) 

faces, colors, sizes, and background colors. These settings are specified for each item, or in a 

"style sheet", which is a type of template for specifying how different styles should appear 

throughout a Web page or site. 

You can override any or all of these settings, which is useful if you have limited or low vision. 

You can specify your font and color preferences for all pages that do not use style sheets, and 

then you can specify whether to use any or all of your preferences on pages that use style sheets. 

*********************************** 

To change the appearance of the Windows toolbar 

• You can add or remove standard toolbar buttons, use smaller toolbar buttons like the ones 

used in Microsoft Office, and change the order they are displayed on the toolbar. Just 

right-click the toolbar, and then click Customize.  

• You can move or resize the Address bar and Links bar by dragging them up, down, left, 

or right. You can even move them into the menu bar!  

• You can hide the Address bar or Links bar by right-clicking the toolbar, and then clearing 

the check mark for each item you want to hide.  

• You can add items to the Links bar by dragging the icon from the Address bar or 

dragging a link from a Web page.  

• You can rearrange items on the Links bar by dragging them to a new location on the bar.  

To display Web page text larger or smaller 

• On the View menu, point to Text Size, and then click the size you want. . 



To change how Web page colors are displayed 

1. On the Tools menu in Internet Explorer, click Internet Options.  

2. On the General tab, click Colors.  

3. Change the settings as needed.  

To specify fonts and colors to always use for Web pages 

1. On the Tools menu in Internet Explorer, click Internet Options.  

2. On the General tab, click Accessibility.  

3. Change the settings as needed 

 *****************************************************************************

******* 

 

SMTP reply codes 

See rfc2821 for the basic specification of SMTP; see also rfc1123 for important additional 

information.  

See rfc1893 and rfc2034 for information about enhanced status codes. 

Check the RFC index for further mail-related RFCs.  

Reply codes in numerical order  

Code Meaning  

200 (nonstandard success response, see rfc876) 

211 System status, or system help reply 

214 Help message 

220 <domain> Service ready 

221 <domain> Service closing transmission channel 

250 Requested mail action okay, completed 

251 User not local; will forward to <forward-path> 

354 Start mail input; end with <CRLF>.<CRLF> 

421 <domain> Service not available, closing transmission channel 

450 Requested mail action not taken: mailbox unavailable 

451 Requested action aborted: local error in processing 

452 Requested action not taken: insufficient system storage 

500 Syntax error, command unrecognised 

501 Syntax error in parameters or arguments 

502 Command not implemented 



Reply codes in numerical order  

Code Meaning  

503 Bad sequence of commands 

504 Command parameter not implemented 

521 <domain> does not accept mail (see rfc1846) 

530 Access denied (???a Sendmailism) 

550 Requested action not taken: mailbox unavailable 

551 User not local; please try <forward-path> 

552 Requested mail action aborted: exceeded storage allocation 

553 Requested action not taken: mailbox name not allowed 

554 Transaction failed 

Reply codes grouped by command  

Command  Code Description  

connect  

  

 220 <domain> Service ready 

 421 <domain> Service not available, closing transmission channel 

HELO  

  

 250 Requested mail action okay, completed 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 504 Command parameter not implemented 

 521 <domain> does not accept mail [rfc1846] 

 421 <domain> Service not available, closing transmission channel 

EHLO  

  

 250 Requested mail action okay, completed 

 550 Not implemented 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 504 Command parameter not implemented 

 421 <domain> Service not available, closing transmission channel 

MAIL 

  

 250 Requested mail action okay, completed 

 552 Requested mail action aborted: exceeded storage allocation 

 451 Requested action aborted: local error in processing 

 452 Requested action not taken: insufficient system storage 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 421 <domain> Service not available, closing transmission channel 



Reply codes grouped by command  

Command  Code Description  

RCPT 

  

 250 Requested mail action okay, completed 

 251 User not local; will forward to <forward-path> 

 550 Requested action not taken: mailbox unavailable 

 551 User not local; please try <forward-path> 

 552 Requested mail action aborted: exceeded storage allocation 

 553 Requested action not taken: mailbox name not allowed 

 450 Requested mail action not taken: mailbox unavailable 

 451 Requested action aborted: local error in processing 

 452 Requested action not taken: insufficient system storage 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 503 Bad sequence of commands 

 521 <domain> does not accept mail [rfc1846] 

 421 <domain> Service not available, closing transmission channel 

DATA  

  

 354 Start mail input; end with <CRLF>.<CRLF> 

 451 Requested action aborted: local error in processing 

 554 Transaction failed 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 503 Bad sequence of commands 

 421 <domain> Service not available, closing transmission channel 

received data   

 250 Requested mail action okay, completed 

 552 Requested mail action aborted: exceeded storage allocation 

 554 Transaction failed 

 451 Requested action aborted: local error in processing 

 452 Requested action not taken: insufficient system storage 

RSET 

  

 200 (nonstandard success response, see rfc876) 

 250 Requested mail action okay, completed 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 504 Command parameter not implemented 

 421 <domain> Service not available, closing transmission channel 



Reply codes grouped by command  

Command  Code Description  

SEND 

  

 250 Requested mail action okay, completed 

 552 Requested mail action aborted: exceeded storage allocation 

 451 Requested action aborted: local error in processing 

 452 Requested action not taken: insufficient system storage 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 502 Command not implemented 

 421 <domain> Service not available, closing transmission channel 

SOML 

  

 250 Requested mail action okay, completed 

 552 Requested mail action aborted: exceeded storage allocation 

 451 Requested action aborted: local error in processing 

 452 Requested action not taken: insufficient system storage 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 502 Command not implemented 

 421 <domain> Service not available, closing transmission channel 

SAML 

  

 250 Requested mail action okay, completed 

 552 Requested mail action aborted: exceeded storage allocation 

 451 Requested action aborted: local error in processing 

 452 Requested action not taken: insufficient system storage 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 502 Command not implemented 

 421 <domain> Service not available, closing transmission channel 

VRFY  

  

 250 Requested mail action okay, completed 

 251 User not local; will forward to <forward-path> 

 550 Requested action not taken: mailbox unavailable 

 551 User not local; please try <forward-path> 

 553 Requested action not taken: mailbox name not allowed 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 502 Command not implemented 



Reply codes grouped by command  

Command  Code Description  

 504 Command parameter not implemented 

 421 <domain> Service not available, closing transmission channel 

EXPN 

  

 250 Requested mail action okay, completed 

 550 Requested action not taken: mailbox unavailable 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 502 Command not implemented 

 504 Command parameter not implemented 

 421 <domain> Service not available, closing transmission channel 

HELP  

  

 211 System status, or system help reply 

 214 Help message 

 500 Syntax error, command unrecognised 

 501 Syntax error in parameters or arguments 

 502 Command not implemented 

 504 Command parameter not implemented 

 421 <domain> Service not available, closing transmission channel 

NOOP  

  

 200 (nonstandard success response, see rfc876) 

 250 Requested mail action okay, completed 

 500 Syntax error, command unrecognised 

 421 <domain> Service not available, closing transmission channel 

QUIT  

  

 221 <domain> Service closing transmission channel 

 500 Syntax error, command unrecognised 

TURN 

  

 250 Requested mail action okay, completed 

 502 Command not implemented 

 500 Syntax error, command unrecognised 

 503 Bad sequence of commands 

RJK | Contents 

******************************************************************************

************* 

 



EMAIL PERSONALIZED  
1. Add GREETINGS on the AOL email form . 
2.Click Smiley and select one of the many listed to go on your email. 
Or  
1.click the pencil button on the email form menu bar in center page. 
4.Click SET UP SIGNATURE, fill in the top blank with your email name. 
5.Click CREATE, Type in any message you would like attached to the bottom of your emails. 
 
EXAMPLE: 
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ 
jmaxpjp2@aol.com 
The Villages Computer Club Internet Connection 
-TO LOVE IS TO SERVE- 
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ 
******************************************************************************

******** 

  

  

  
 TWO DIFFERENT DOCTORS' OFFICES  
  
Two patients limp into two different medical clinics with the same complaint.  Both have 
trouble walking and appear to require a hip replacement. 
  
The FIRST patient is examined within the hour, is x-rayed the same day and has a time 
booked for surgery the following week. 
  
The SECOND sees his family doctor after waiting 3 weeks for an appointment, then 
waits 8 weeks to see a specialist, then gets an x-ray, which isn't reviewed for another 
week and finally has his surgery scheduled for 6 months from then. 
  
Why the different treatment for the two patients? 
  
The FIRST is a Golden Retriever. 
The SECOND is a Senior Citizen. 
  
Next time take me to a vet! 
************************************************************************************* 

JmaxJmaxJmaxJmax  

Jmax's Website   http://www.jmaxbits.com/ 
Jmax Bits Newsletter is now posted each Monday & Thursday on the website. 
You have the option for a .pdf or a .rtf file. 
 
1.For help with a computer problem, put HELP in the subject line and give me info 
about the computer you're using, if you know it.  
 



2.To view or print Jmax Bits Good Services List in the Villages area, click link 
www.jmaxbits.com 
 
3. To sign up for the non-computer newsletter, send an email to 
VLGSClassifieds@aol.com. Put SUBSCRIBE in the subject line. To send an Ad, 
place AD in the subject line. 
 
4. The Villages Computer Club's web page: Click here: Welcome To The Villages 
Computer Club 
To add your name to the VCC announcements list, send email to TheVCC-
subscribe@yahoogroups.com 
 

5. Fred Benson's website www.thevillagescomputerbasics.com  
 


